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General 
Meeting 

 
• Basic Questions and 

Answers 
• Announcements 
• Club Business 
• Site Seekers: Ric Fischer 
• Buy, Sell, or Trade 
• Prize Drawing 

 
 
Bring your friends and 
neighbors! 

 
c 

Arizona Society for 
Computer Information, inc. 

Presentations 
 

Joe Benedetto will give a 
demonstration of the 
new version of Paint 
Shop Pro 9 by Jasc 

Software. 
Ric Fischer will show off 

a brand new product 
from Jasc Software 

called Paint Shop Pro 
Studio. 

President’s Message 
Technology marches on 

That’s a truism that shapes our world in ways we seldom think 
about, and we should think about some of those ways. 

Here’s a few: 

When you buy a piece of hardware for your computer, you should 
check for newer drivers than what came in the box, before you 
install that hardware. Just go to the website of the people who 
make the device and download the new drivers. When you install 
the device, the newer drivers will be right there for you. Burn the 
new drivers to a CD-R, and put it in the box, so you’ll have it if you 
need it later. Checking for newer drivers every few months is a good 
idea too. 

Speaking of that box, I sometimes just put the manual and CDs 
that go with it in a Ziplock bag; this saves a lot of shelf space. 

One of the most cost effective ways to speed up your computer 
may still be to add RAM. If you’re running Windows XP and have 
less than 256 MB of RAM, adding RAM to get to 512 MB may well 
speed things up noticeably. RAM still is pretty inexpensive. 

As you read those ads that come in the Friday paper for a certain 
electronics store, you may notice that there’s not really enough in-
formation about some of the things advertised to let you know what 
they are really selling, or if the price asked is a bargain. Google to 
the rescue! Usually, there’s a model number/name in the ad; use 
Google to check on what that particular item really does. This is 
especially helpful if, for example, you’re looking for something like 
a motherboard/CPU upgrade. Google will lead you to the manufac-
turer’s site, and sites that have reviews of the hardware being of-
fered, where you can check to see what that motherboard will do for 
you (or won’t do). 

(Continued on page 2) 
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ASCIi OFFICERS 
President  Bill Funk 602-526-2094 
Vice-President Kevin Svec 602-680-2870 
Secretary Hank Pearson 602-944-2965 
Treasurer Bob Nixon 602-284-0547 
 
COMMITTEES 
Clipboard Editor Ric Fischer 
Contributing Editors Bill Funk, Hank Pearson 
Membership Committee Bill Funk, Phyllis Baughman 
Review Committee Joe Benedetto 
“Doc Elwell” Phone Tree Carl Cole, Pat Patchin 
Vendor Coordinator Joe Benedetto 
Site Seekers Coordinator Phyllis Baughman 
Webmaster Ric Fischer 
APCUG, AZacc, Mindshare Representative Ric Fischer 
 
ASCIi 
Arizona Society for Computer Information, inc. is a non-
profit computer user group that formed well over 16 years ago. 
ASCIi is just computer people helping computer people by sharing 
information and talents. ASCIi is affiliated with APCUG, AZacc, and 
Mindshare. 
ASCIi has a general meeting on the second Saturday of the month in 
the ABACUS building at 3rd Street and Earll Dr. 
ASCIi also has an Eastside meeting on the fourth Saturday of the 
month at Pyle Adult Recreation Center,  655 E. Southern Ave., 
Tempe, AZ. This meeting consists of the Steering Committee 
followed by an open forum. 
• The Steering Committee meets at 12:30 P.M. and lasts about 1 

hour. All members are encouraged to attend and contribute their 
ideas for the future of your user group. 

• Hardware and software problems are welcome at the open 
forum, which begins at 1:30 P.M. 

 
New users are welcome and membership in ASCIi is not required to 
attend the meetings. 
 
More information may be obtained by visiting the ASCIi website at 
www.asciigroup.org, contacting one of the ASCIi officers, or by 
writing: 
Arizona Society for Computer Information, inc. 
1934 E. Laguna Dr. 
Tempe, AZ 85282-5913 

The RIAA (Recording Indus-
try Association of America) 
had better figure out how to 
make money from P2P (Peer 
to Peer) networking; their cur-
rent business plan of trying to 
scare their would-be custom-
ers, and making them mad at 
the RIAA, isn’t a valid, long-
term plan. As technology 
marches on, these people who 
need customers would be far 
better served by finding ways 
to get the customers to buy, 
rather than finding ways to 
make them mad. 

As hard drives get bigger 
(and cheaper), we need to 
come to terms with ways to 
keep our data safe. Obviously, 
swapping out 3.5” floppies for 
a backup isn’t going to work. 
Tape drives (remember the 
old 100 MB Colorado tape 
drives?) are not a good solu-
tion, because the ones we can 
afford aren’t really very reli-
able. Using CD-Rs or even 
recordable DVDs isn’t going to 
work when there are upwards 
of 500 Gigabytes of drivespace 
to back up. (Yes, I have almost 
that much; it isn’t all used yet, 
but I remember when I could-
n’t see how I could fill up a 32 
MB drive.) New strategies are 
needed; maybe just making a 
backup of everything at once 
is no longer the best one. The 
data is obviously the most im-
portant, so keeping copies of 
all of my data is the first prior-
ity. Then, I’ve got one parti-
tion for just my OS and the 
installed applications; that’s 
imaged onto a removable hard 
drive and kept reasonably up 
to date. If that partition goes 
south, I can just restore the 
latest image and I’m good to 
go. But what about my 

(Continued from page 1) 
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downloaded files? Yes, they 
need to be kept safe, too. For 
these and data files, record-
able CDs and DVDs seem to be 
a good choice; they are cheap 
(even recordable DVDs are 
well under a dollar apiece), 
and small enough that multi-
ple copies take up little space. 
And I somehow still manage to 
lose stuff. :-( 

Vacations are wonderful 
things; they are even wonder-
ful to remember. This is where 
a decent camera (or two) 
comes in handy. On our recent 
vacation, I took two cameras, 
both digital; my new still cam-
era, and our not-so-new video 
camera. I took lots of photos 
and videos, and I’m in the 
process of sorting and doing 
all the other stuff to make 
them the way I want them. I 
then store them on CDs and 
DVDs, and put some on my 
website for others to enjoy. I 
find that being able to go 
through photos of good times 
like vacations helps me to re-
member things I’d otherwise 
forgotten. I take a lot of pic-
tures (though not as many as I 
should). With digital, once you 
get over the initial costs, the 
pictures are virtually free. The 
cost is the same if I take 
twenty, or two hundred. Guess 
which will help you remember 
more? And the newer video 
rendering software packages 
are getting pretty amazing; I 
can (and have) made music 
videos of various activities 
(bull riding, anyone?) with just 
a few clicks of my mouse. 
Now, there’s a thought for 
Christmas presents! 

by Bill Funk, 
ASCIi President 
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(Continued from page 2) 
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FireFox Keymarks 

Back in the “good old days”, we entered 

 dir 

to display a directory listing. Thanks to the mouse and GUI 
(Graphical User Interface), we no longer need to type commands. 

Ironically, we think commands are bad but keywords are good. 
Every day we search for keywords with Google. What if we could 
enter keywords to go directly to a few popular websites and even 
look up information on those websites without filling in forms? 
We’d save lots of typing, mouse movement, and carpal tunnel syn-
drome. 

For example, you know you’d look up more words in a real diction-
ary if it was easy. Seems like it would be handy to enter 

 define analog 

in the browser Location Bar to look up the word ‘analog’. 

In Google, you can enter 

 define analog 

to search for a definition, but you would like to use Merriam-
Webster if it is just as easy. No problem. What you want is a key-
mark (keyword bookmark) and FireFox makes keymarks simple. 

You aren’t using FireFox? Oh, you’ll like FireFox. FireFox is a 
browser, like Internet Explorer, but faster, safer, and better. Fire-
Fox is completely free, is not ad-supported, features tabbed brows-
ing, has many extensions, automatically blocks popups, offers cus-
tom themes, and provides more control over font size. 

There is no reason not to use FireFox, and even if you install it just 
to use keymarks, it’s well worthwhile. FireFox does not disable 
Internet Explorer. You can use either browser, but you will prefer 
FireFox. 

Visit mozilla.org/products/firefox, download the setup 

(Continued on page 4) 

Change of Address? 
 

Or any other change we should know about? E-mail address 
change? 
 

Let our Membership Committee know by talking to either Bill Funk 
or Phyllis Baughman at the main meeting, or by emailing them at: 
membership@asciigroup.org 
or by phone (their numbers are on the telephone & email list 
available at the main meetings). 
 

c 
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file, restart your computer (like you should before installing any 
program), and run the setup. 

In FireFox, if you don’t know where the dictionary is, enter 

 Meriam-Webster 

in the built-in Google Search Bar near the top right corner of the 
window. (You don’t even need to open the Google page or use the 
Google toolbar, although it is available for FireFox.) 

Click on the Meriam-Webster Online link, or enter m-w.com 
in the Location Bar. Type a word to define, like 

 analog 

in the dictionary textbox and press Enter. 

In the menu bar, click Bookmarks, and then Bookmark This Page. 
In the ‘Create in’ drop-down list, select Bookmarks, and click OK. 

Click the Bookmarks menu again, click Manage Bookmarks, right 
click your new bookmark, and click Properties. 

In the Name textbox, type a word similar to your bookmark key-
word. For example, if you want to use the word define as your 
keyword, then you could name the bookmark 

 -define 

with the leading hyphen. That way, you’ll have a handy list of key-
marks in your bookmarks menu. 

In the Location textbox, replace the word analog with 

 %s 

The %s will later be replaced automatically with the term you want 
to define. 

In the Keyword textbox, type the keyword you will use to look up a 
definition: 

(Continued from page 3)  define 

Type an optional description 
as a reminder: 

 Define word in 
Meriam-Webster 

Click OK and close the Book-
marks Manager window. 

You have created your first 
keymark. Try it out! In the 
Location Bar, type 

 define digital 

and press Enter. There’s your 
definition. Couldn’t be much 
easier. 

But after using your keymark 
three or four times, you tire of 
typing the whole word de-
fine. In the Bookmarks 
menu, click Manage Book-
marks, right click -define, 
click Properties, and change -
define and define to -def 
and def (or even -d and d). 
Click OK and close the Book-
marks Manager. 

You think the built-in Google 
Search Bar is too narrow? It 
isn’t wide enough to show 
long search terms, and it 
shortens up the Location Bar 
so you can’t see long ad-
dresses. Make a keymark for 
Google and then remove the 
built-in Google Search Bar: 

Search for anything in Google 
- say vote. Click the Book-
marks menu and then Book-
mark This Page. Now click the 
Bookmarks menu, click Man-
age Bookmarks, right click the 
new bookmark, and click 
Properties. Change the Name 
to -goo (or or even -g). In 
the Location, replace the word 
vote with %s. For the Key-
word, type goo (or g). In the 

(Continued on page 5) 

The ASCIi ClipboardThe ASCIi Clipboard  

Get Your 15 Minutes of Fame! 
 
Would you like to be listed right at the top of the who’s who list? 
Would you like your name next to the likes of some other ASCIi 
member? You may be thinking to yourself, “How can I do it?” It’s 
easy. Just write an article about anything to do with computers. It 
can be about your favorite program, something fun you do with 
your computer, or even about something you’ve seen or heard 
someone else do with their computer. Long or short, we take it all! 
 

Send your questions or, better yet, your articles to 
editor@asciigroup.org. 

 
c 
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Ask Mr. Modem! 
Q. How can I request a return receipt for email I send us-

ing Outlook Express? 

A. You can configure Outlook Express to request a “read receipt” 
when the recipient of the email has displayed your message. Just 
keep in mind that recipients can elect NOT to send a receipt, even if 
it is requested. They can do that by clicking Tools > Options > Re-
ceipts and then selecting “Never send a read receipt,” or they can 
click the Never button when requested to acknowledge receipt of an 
email. 

As the sender, to request a read receipt for individual (specific) 
messages, click the Tools menu in the new message window, then 
click “Request Read Receipt.” 

To request a read receipt for all messages, click the Tools > Op-
tions > Receipts tab. Select the “Request a read receipt for all sent 
messages” check box. 

Q. I have an older computer running Windows 98. When 
I use my word processing software, I can’t insert a letter 
(character) into a word or a sentence without canceling 
the letter next to it. If I hit the space bar, instead of mov-
ing the text ahead of it, it deletes the text letter by letter. 
Do you have any suggestions? 

A. It sounds like you may have inadvertently toggled the INS 
(Insert) key off. With the INS key off, anything you type will over-
write other letters. With the INS key on, anything you type will in-
sert itself at the location of your cursor and shove existing letters to 
the right. How rude! 

To toggle it on, press the INS key on your keyboard. Each time you 
(Continued on page 6) 

Eastside Meetings 

On the fourth Saturday of every month, we have two meetings. 

Steering Committee: 12:30 P.M. 
Every member present is on the committee, which is when 
decision are made. This is your club. It needs your input! 

General Eastside Meeting: 1:30 P.M. 
If you’re having a hard time with you computer or you’ve got 
questions, this is definitely the meeting to attend. 

Address 
Pyle Adult Recreation Center 
655 E. Southern Ave., Tempe, AZ 

For further info, call Bill @ (602) 526-2094. 

c 

Description, type Google. 
Click OK and close the Book-
marks Manager. 

Click the View menu, point to 
Toolbars, and click Customize. 
Drag the search textbox into 
the customization dialog, and 
click Done. 

Now you have a longer Loca-
tion Bar. To Google for cele-
brate, type 

 goo celebrate 

in the Location Bar and press 
Enter. 

One more example. You often 
search in Microsoft but you 
like Google’s search better. 
Make a keymark for Google to 
search Microsoft. 

In Google, type 

 SP2 RC2 site:microsoft.com 

and press Enter. Save the 
bookmark and edit its proper-
ties, as explained above, using 
-ms for the Name, changing 
SP2 RC2 to %s in the Loca-
tion, typing ms for the Key-
word, and noting Google in 
Microsoft in the Descrip-
tion. 

To try out the new keymark, 
press F6 to select text in the 
Location Bar, type 

 ms longhorn 

and press Enter. 

Aren’t you glad you switched 
to FireFox? 

by Hank Pearson, 
ASCIi Secretary 

c 

(Continued from page 4) 

The ASCIi ClipboardThe ASCIi Clipboard  



6 

press the key it will turn the INS feature on or off. When it’s on, you 
should see the small letters INS (for insert) or OVR (for overwrite) 
in the lower portion of your screen or on one of the displayed tool-
bars, depending on the program in use at the time. 

Q. How do I get rid of all the email addresses in the 
header of a message I want to forward to someone? 

A. Depending on the capabilities of your email program, if you 
click the Forward button, you may be able to edit the message 
you’re about to forward, delete email addresses and any other ex-
traneous text. If your email program lacks that capability, try fol-
lowing these steps: 

1. Select (highlight) the part of the message you want to forward. 

2. Right-click and select Copy from the menu presented. 

3. Create a new email, address it, type in a Subject line and move 
your cursor to the body of the message area. 

4. Right-click and select Paste from the menu. Your selected text 
will pop into the new email. You can then continue editing or 
simply send the message as you normally would. 

Q. My Palm computer has frozen up solid. I can’t do any-
thing with it. None of the buttons work and using the sty-
lus on the screen has no effect at all. Is it ruined? 

A. Probably not. The best thing to do whenever your Palm device 
freezes -- even better than whacking it on a desk -- is to perform 
what’s called a “soft reset.” Sounds very comforting, doesn’t it? Just 
insert a paper clip into the small reset hole located on the back of 
the device itself until the unit turns back on. Performing a soft reset 
has the same effect as rebooting your desktop computer. 

by Richard A. Sherman, www.mrmodem.com 
 
(c) 2004 Get-the-Net, Inc. All rights reserved. 
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(Continued from page 5) Nay-Sayers 
“Computers in the future may 

weigh no more than 1.5 tons.” 
--Popular Mechanics, fore-
casting the relentless march of 
science, 1949 

“I think there is a world mar-
ket for maybe five computers.” 
--Thomas Watson, chairman 
of IBM, 1943 

“I have traveled the length 
and breadth of this country 
and talked with the best peo-
ple, and I can assure you that 
data processing is a fad that 
won’t last out the year.” --The 
editor in charge of business 
books for Prentice Hall, 1957 

“But what ... is it good for?” --
Engineer at the Advanced 
Computing Systems Division 
of IBM, 1968, commenting on 
the microchip. 

“There is no reason anyone 
would want a computer in 
their home.” --Ken Olson, 
president, chairman and foun-
der of Digital Equipment 
Corp., 1977 

“This ‘telephone’ has too 
many shortcomings to be seri-
ously considered as a means 
of communication. The device 
is inherently of no value to 
us.” --Western Union internal 
memo, 1876. 

“The wireless music box has 
no imaginable commercial 
value. Who would pay for a 
message sent to nobody in 
particular?” --David Sarnoff’s 
associates in response to his 
urgings for investment in the 
radio in the 1920s. 

“The concept is interesting 
and well-formed, but in order 

(Continued on page 7) 
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Improve Your User Group 
The ASCIi Clipboard could use your help to improve things. This 

group gets better when its members help out. If you’d like to write 
an article, send it to the editor at editor@asciigroup.org by the last 
Wednesday of the month and it’ll go in next month’s issue. 

If you’d like to help out with a presentation, either by suggesting a 
topic or doing a presentation, let the president know at 
president@asciigroup.org. 

c 
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use service is free of cost and advertisements, and its large database 
of videos is continually updated with user contributions. 

www.memvideo.com 

Sports Cliches 

Culled from the transcripts of countless interviews, this searchable 
index of clichés will have you talking like a real media professional 
in no time. “It’s going down to the wire. It’s a real pressure cooker. 
It’s a whole new ballgame.” Get the idea? So if you’ve got tremen-
dous mental toughness and the will to win, stay focused, dig deep, 
and step up to the plate. Sports broadcasts will never sound the 
same again. 

www.sportscliche.com 

by Richard A. Sherman, www.mrmodem.com 
(Do you have a question for Mr. Modem? Join subscribers world-
wide who receive Mr. Modem’s Weekly newsletter and prompt re-
sponses to their questions. For more information visit 
www.MrModem.com.) 

(c) 2004 Get-the-Net, Inc. All rights reserved. 
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Mr. Modem’s 
DME(Don’t 
Miss ’Em) 

Sites of the 
Month - Sep-
tember 2004 

Meatless Monday 

Not your World War II Meat-
less Mondays, but rather an 
outstanding national public 
health initiative to help Ameri-
cans prevent heart disease, 
stroke, and cancer. The tone of 
this site is informative, inspi-
rational, and fun! Updated 
weekly, you’ll find delicious 
low-fat and no-fat recipes, 
food- and health-related facts 
you can rely on, and even 
money-saving coupons and 
giveaways. Advisors to the site 
include Johns Hopkins, Co-
lumbia, Cornell, and this is 
one time when we don’t want 
to hold the Mayo (as in Mayo 
Medical School), and other 
highly respected leaders in the 
health community. 

www.meatlessmonday.com 

MemVideo For Video Lovers 

Have you ever rented or taped 
a movie, only to realize a few 
minutes into it that you’ve 
seen it before. I hate it when 
that happens! If you’re a 
movie buff, MemVideo invites 
you to be your own movie re-
viewer and track what you’ve 
seen, or what tapes or DVDs 
you own, and provide your 
own ratings and commentary. 
You can access your privately 
stored information on the 
Internet or by mobile phone 
any time, from any location. If 
you love movies, this easy-to-
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to earn better than a ‘C,’ the idea must be feasible.” --A Yale Univer-
sity management professor in response to Fred Smith’s paper pro-
posing reliable overnight delivery service. (Smith went on to found 
Federal Express Corp.) 

“Who the hell wants to hear actors talk?” --H.M. Warner, Warner 
Brothers, 1927. 

“I’m just glad it’ll be Clark Gable who’s falling on his face and not 
Gary Cooper.” --Gary Cooper on his decision not to take the leading 
role in “Gone With The Wind.” 

“A cookie store is a bad idea. Besides, the market research reports 
say America likes crispy cookies, not soft and chewy cookies like you 
make.” --Response to Debbi Fields’ idea of starting Mrs. Fields’ 
Cookies. 

“We don’t like their sound, and guitar music is on the way out.” --
Decca Recording Co. rejecting the Beatles, 1962. 

“If I had thought about it, I wouldn’t have done the experiment. 
The literature was full of examples that said you can’t do this.” --
Spencer Silver on the work that led to the unique adhesives for 3-M 
“Post-It” Notepads. 

“640K ought to be enough for anybody.” -- Bill Gates, 1981 

Found on www.ComputerJokes.net 
c 

(Continued from page 6) 
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Westside Meetings 
 

ABACUS  building 
3rd Street & Earll Drive 

Phoenix, AZ 
 

The second Saturday of each Month 
at 12:30 P.M. 

Eastside Meetings 
 

Pyle Adult Center 
655 E. Southern Ave. 

Tempe, AZ 
 

The fourth Saturday of each Month. 
Steering: 12:30 P.M. — Q&A: 1:30 P.M. 

ABACUS 
Building 

Earll Drive 
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